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Getting Started 

Step 1: The first step in using the eCourse is registering the course access code. Your 
access code will look something like this: DSSCLZ-BOREE-CYNIC-PLUMB-DOLBY-WISES. 

Registering an Access Code 
1. In your Web browser, go to www.pearsoncustom.com/us/MSOffice2013. 

 Notice the links on the left side of the screen. These provide written and video 
instructions for getting started. 

2. Under Register, click Click Here. 
3. Click I Accept to continue. 
4. If you do not have a Pearson account, click No and enter the requested information, 

including entering the code. Be sure to record the user name and password that you 
enter as that is what you will use to log in to the eCourse in the future. 
OR 

 If you have already have a Pearson account, click Yes then check the information 
and enter the access code.  

5. Click Next. 
6. Fill out or check the required information and then click Next.  
7. Click Log In Now. The My Courses and Testbanks page displays. This page is 

always the first thing you see when you log in.  

Logging In 
1. Go to www.pearsoncustom.com/us/MSOffice2013. 
2. Under Login, click Click Here. 
3. Enter your username and password and click Sign In. 

 Note that the password is case-sensitive. 

Step 2: Next, you must create the course, or, if a program administrator has created 
the course and given you a Course ID, you must enroll in the course as a teacher. 

Creating a New Course 
1. Log in, if you haven't already done so. 
2. On the My Courses and Testbanks page, click Create a Course. 
3. Click the Browse by Discipline drop-down arrow. 
4. Click Computing. 
5. Click Next. The names of all courses you have access to display. 
6. To the right of the course you want to create, click Select Program. 
7. Type a name and description for the course. This name will display on your My 

Courses and Testbanks page.  
8. Click Finish. The course displays on the My Courses and Testbanks page. 
9. Click the course name to display the Program Administration page, with the 

Templates tab active. It will take a few minutes for the course template to become 
available. 
 Notice that the Program Administration page has five tabs: Templates, Sections, 

Users, Enrollments, and Reports. 

http://www.pearsoncustom.com/us/MSOffice2013
http://www.pearsoncustom.com/us/MSOffice2013
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Enrolling in an Existing Course 
 Note that students will use these same steps to enroll in your course section. 

1. Log in. 
2. On the My Courses and Testbanks page, click Enroll in a Course. 
3.  Enter the course ID and click Submit. 
4. Verify the course information and click Finish. The course displays on the My 

Courses and Testbanks page. 
5. Click the course name to enter the course. 

 Note: If you enrolled in an existing course, you are now all set to use the course 
and can skip ahead to Step 4. You do not have access to the template and will 
always work in your own class section. 
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Understanding Templates and Sections 

 When you create a new course, you set up the default Master Template. 
Everyone, everywhere, who creates this course has the same Master Template 

 In order to enroll students, you must create course sections.  

 Sections are based on a template. If you create sections based on the default 
Master Template those sections will have the default settings. If you customize 
the template before creating sections, the sections will have the customized 
settings. 

 You can also customize sections. Most customizations made to a section affect 
that section only. However, there are some exceptions. For example, when you 
make an assignment in a section you have the option of applying that assignment 
to other sections. 

 You will create one section for each class you teach. Students enroll in the section 
you assign, using the section course ID, which is generated when you create the 
section. 

 You can work in either the template or a section. You would work in the template 
if you want to make customizations that will affect all sections. You would in a 
specific section when you want to manage that class, or make customizations 
that affect only that section. 

Copying the Template and Creating Sections 

Step 1: It is a good idea to create a copy of the Master Template. Then you can 
customize the template if you want, but can always revert back to the original if 
necessary. 

Copying a Template 
1. Log in. 
2. On the My Courses and Testbanks page, click the course name. 
3. On the Program Administration Templates tab, rest the mouse pointer on the 

template name to display the Options down arrow. 
 Note that most items in the eCourse have an Options menu. It is always a good 

idea to look on the Options menu for common tasks relating to that item. 
4. Click the Options arrow and then, on the Options menu, click Copy as Template. 
5. Enter a name. Do not enter a start or end date. You may enter a description if you 

want. 
6. Click Copy. It will take a few minutes for the template copy to become available. 
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Step 2: You will create one section for each class you teach. Sections are based on a 
template. Students will enroll in their assigned section using the Course ID. 

Creating a Section 
1. Log in. 
2. On the My Courses and Testbanks page, click the course name. 
3. On the Program Administration page, click the Sections tab. 
4. Click Add Sections. 
5. Type a name for the section. This name will display on students' My Courses and 

Testbanks page when they log in. 
6. Click the Content Template drop down arrow and select the template on which you 

want to base the section. This may be the master template or the copy, depending 
on which one you have customized. 

7. Enter the number of sections you want to create. If you create more than one, they 
will be named by adding a hyphen and a number to the end of the name entered in 
step 5. You may rename them later, using the section's Options drop-down menu. 

8. Select a Start Date, usually today. 
9. Select an End Date. We recommend selecting an End Date far in the future. 

Although you can change this at any time by editing the section properties, it is likely 
you or the students will want to access the course after the semester, so you may as 
well enter an end date that allows extra time. 

10. Enter a description if you want, and then click Add and Close. It will take a few 
minutes for the section to become available, but the Course ID is generated 
immediately. It displays to the right of the section name. Give this ID number to the 
students you want to enroll in this section. 

 
  

Course ID 
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Renaming a Section 
1. Log in. 
2. On the My Courses and Testbanks page, click the course name. 
3. On the Program Administration page, click the Sections tab. 
4. Rest the mouse pointer on the section to rename. 
5. Click the section's Options down arrow. 
6. Click Edit Section Information. 
7. Change the name (and any other information you want to change). 
8. Click Update. 

Entering eCourse 

Step1: The first step is to enter the eCourse.  
 Note: If you are an enrolled teacher and not a program administrator, you enter 

your section by clicking the course name on the My Courses and Testbanks 
page. 

Entering an eCourse Template 
1. Log in. 
2. On the My Courses and Testbanks page, click the course name. 
3. On the Program Administration page, on the Templates tab, click the template you 

want to enter. The Today's View tab displays. 

Entering an eCourse Section 
1. Log in. 
2. On the My Courses and Testbanks page, click the course name. 
3. On the Program Administration page, click the Sections tab. 
4. On the Sections tab, click the section you want to enter. The Today's View tab 

displays 

Step2: Next, you can practice switching between Instructor View and Student View.  

 Every instructor account comes with a built-in student account that you can 
use to see what the students are seeing and to test activities.  

 The built-in account is for a student named student_student.  

 You can switch to Student View at any time without logging out and logging 
back in, and then switch back to Instructor view. 

Switching to Student View 

1. Click the Go to Student View  button in the upper-right corner of 
the course window. Student View opens to whatever screen you were looking at 
in Instructor View. 
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Returning to Instructor View 

1. Click the Return to Instructor View  button in the upper-right 
corner of the course window.  

Using Today's View 

 Today's View is the first thing you or a student sees when you enter the 
eCourse.  

 On the left side of the window are Notifications, including alerts, such as new 
grades, and action items, such as items waiting for you to enter a grade.  

 In the middle of Today's View is the Welcome Message area which you can 
customize to communicate with students.  

 On the right side of Today's View are the monthly calendar and system 
announcements. The calendar displays an alarm clock icon if there is an 
assignment due.  

Step 1: Customizing Notifications. By default, all available notifications are listed. 
You can use the Customize Notifications dialog box to deselect the ones you do not 
need.  

Customizing Notifications: 
1. Click the CUSTOMIZE button. 
2. Scroll down and clear the check boxes for the items you do not want to display. 
3. Click Save and Close. 
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Step 2: Customizing the Welcome Message. This message is a great way to 
communicate with students because it is the first thing they will see when they 
enter the course. You can list expectations, remind them of due dates, and so on.  

Customizing the Welcome Message: 
1. Click the CUSTOMIZE button. 
2. Select Welcome Message from the Default View drop down list. 
3. Under Welcome Message, click to select both the Edit Welcome Message and 

Enable Welcome Message check boxes. 
4. Use the word processing tools that display to type and format your message. 

This message will display in the Message area for you and students enrolled in 
the section. 

5. Click Save and Close. 

Step 3: Using the Calendar  

Using the Calendar 
 Click an icon to view the assignment in the Assignment Calendar.  

 Double-click any date to go to that date in the Assignment Calendar.  
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Using the Course Materials Tab 

 The Course Materials tab provides access to all of the content available in the 
course. 

 On the left side of the window is the Course Materials Library, which contains 
all of the source content for the course. You will rarely, if ever, need to use the 
content in the Course Materials Library. 

 On the right side of the Course Materials window is all the content for your 
course. You can preview and manage the content from this location.  

 The Course Content is organized in a hierarchy like a table of contents.  

 A link icon indicates a direct link to the content. 

 A folder icon  indicates layers of content. 

Step 1: Locating Course Content. You can navigate through the Course Content by 
clicking to open links or folders, or by using the drop down arrow at the top of the 
list to display a hierarchy tree of all content. 
 

The Learning Office 2013 course includes the following: 

 The eText. The eText is the book in digital format, with embedded links to videos 
and data files. Click this link to open the eText in a separate window. 

 Course content by section. Each section is an application (Basics, Word, Excel, 
Access, PowerPoint). Each application is organized into Chapters, and each 
chapter is organized into Lessons.  

For each chapter you will find: 

 Text Chapter Overview 
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 Video Chapter Overview 

 End of Chapter Projects and Tests 
o File Upload activities that students can use to submit their completed 

application files from the eText projects which you can grade manually 
o Two automatically-graded concept tests 
o Two automatically-graded Grader Projects.  

 Step by step procedures in .pdf format 

 Interactive puzzles 

For each lesson you will find: 

 Direct link to that lesson in the eText 

 Links to the Try It videos for that lesson 

 File Upload activities that students can use to submit their completed 
application files for the Try It and end of lesson projects from the eText, which 
you can grade manually 

 Student Data files. Although these files can be opened using the embedded links 
in the eText, they are also made available as downloadable .zip files. 

 Student Resources. This folder contains links to the following supplemental 
documents; you may open, save, and/or print these documents: 

 Arranging Program Windows (.pdf) 

 Introduction to Computers and the Internet (.pdf) 

 Career Skills (.pdf) 

 Career Clusters (.pdf) 

 Career and Technical Organizations (.pdf) 

 21st Century Skills (.pdf) 

 Language Arts Review (.pdf) 

 Math Review (.pdf) 

 Keyboarding Essentials (.pdf) 

 Glossary (.pdf) 

 Spanish Glossary (.pdf) 

 Teacher Resources. This folder contains links to content to help you teach and 
manage this course. Typical content includes the following: 

 A link to the Teacher's Edition of the text. This will include teaching tips, 
discussion topics, customized instructions suggestions, and more to help you 
teach the course. 

 Solution files for the Grader Projects 

 Solution files for the eText project files 

 Application Test Bank, which includes printable application tests to use as 
pre-tests, post-tests, and a final exam. 

 MOS Resources for students preparing for Microsoft Office Specialist 
certification, including skill mapping guides for each exam and correlations to 
the Grader Projects. 

 Lesson Overview videos for the Excel lessons 

 Visual Aid PowerPoints for each chapter 

 Handbook for Teaching English Language Learners 
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 Pacing Guide 

 Step-by-step procedures for skills not found in the eText that may be required 
to complete the Grader Projects. 

Step 2 Making Course Materials Available to Students 

One way to make content available to students is by setting it to display on the Course 
Materials tab in Student View.  

 In Instructor view, if the word Shown displays under content on the Course 
Materials tab, it means that content is available on the Course Materials tab in 
Student View.  

 If the word Hidden displays, it means that content is not available on the 
Course Materials tab in Student View.  

Toggling the Show/Hide status:  
1. Click to select the check box next to the item. 

2. Click Show/Hide . You can also rest the mouse pointer on the item and use 
the down arrow to access the Show/Hide command. 

Notes on using .PDF Documents 
 When you open a .pdf document in the eCourse, if the Adobe Reader toolbar does 

not display, hover the mouse pointer over the lower-middle portion of the screen to 
display a toolbar with options for saving, printing, scrolling, and changing the zoom. 

 If your browser does not display .pdf documents, you may be missing an Adobe 
Reader plug-in. Use the Pearson Browser Tune Up Link to diagnose the problem: 
http://browsertuneup.pearsoncmg.com/browser_tuneup.html 

 To return to the Learning Microsoft Office eCourse from a .pdf document, click the 
Back button on your browser's toolbar, or, if it opened in a separate window, close 
the window. 

http://browsertuneup.pearsoncmg.com/browser_tuneup.html
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Using the Assignment Calendar 

 The third tab in the eCourse is the Assignment Calendar.  

 You use the Assignment Calendar to select items you want displayed on the 
To-Do list in Student View, and to manage assignment properties.  

 By default, items are assigned without a due date and are available to all 
students all the time. You can set assignment properties to add a due date, set 
an availability date range, and select specific students. Other properties are 
available as well.  

 You can assign any item from the course content; however, in most courses 
you will assign the specific work you want students to complete, such as the 
eText for a specific lesson, a File Upload activity, a concept test, or a Grader 
Projects. Since content is available to students on the Course Materials tab, 
you do not have to use the Assignment Calendar to make content available. 
Use it to let students know what you expect them to work on and complete. 
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Step 1: Creating Assignments 

Creating an Assignment with Default Properties 
1. Click the Assignment Calendar tab. By default, content is displayed in Table of 

Contents View, just like on the Course Materials tab. 
 You can change the View to display items by Type. Click the View By drop-down 

arrow and click Content Type. 

2. Navigate to the specific item you want to assign and click to select the check box 
next to it. You can assign multiple items at the same time if you want. 

3. Click the Assign/Unassign   button. If a message displays 

informing you that the item is currently hidden from students, click Yes to create 
the assignment and show the item. 
 You can also assign an item from the Course Materials tab. Select it in the Course 

Content list and click the Assign/Unassign button. 

Dragging an Assignment to the Calendar 
1. On the Assignment Calendar tab, navigate to the item you want to assign. 
2. Drag the item on to the calendar and drop it on the date you want it due. The 

item is assigned with that due date, and all other default assignment settings. 

Setting Assignment Properties 
1. On the Assignment Calendar tab navigate to the specific item you want to assign. 
2. Rest the mouse pointer on it to display the Options down arrow. 
3. Click the Options down arrow and then click Assignment Properties to open 

the Assignment Properties window. If a message displays informing you that the 
item is currently hidden from students, click Yes. 

  
4. Under Assign, click to select the Assigned option button. This sets the 

assignment to have today as the due date. 
5. Select the due date you want, or, to assign the item without a due date, clear the 

Assign with due date check box. 
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6. To set an availability date range, click to select the Set availability date range 
option button, and then select the start and end dates. Select other availability 
options that you want. 

7. Click the Plus sign to the left of Advanced Options to view or set additional 
properties. Notable advanced options include: 

a.  assigning an item to specific students 
b.  requiring a proctor password 
c. applying the assignment to other sections based on the same template. 

8. Click the Save button.  
 From the Course Materials tab, click the item's Options down arrow and click 

Properties to open the Assignment Properties page. 

To Unassign an Assignment 
1. On the Assignment Calendar tab, select the item you want to unassign. 
2. Click the Assign/Unassign   button. 

OR 
1. Click the item's Options down arrow and then click Assignment Properties. 
2. Click the Unassigned option button. 
3. Click Save. 

 Note you can assign an item from the Course Materials tab as well. Select it in the 
Course Content list and click the Assign/Unassign button. 

Step 2: You may want to check to see how the assignments will appear to students. 
You do this by switching to Student View and navigating to the To-Do list. 

Locating Assignments in Student View 

1. Click the Go to Student View  button in the upper-right corner of 
the course window.  

2. If necessary, click the Assignments tab. The Course Calendar page displays the 
monthly calendar on the left and a list of items due today on the right. 

3. Click To-Do on the menu bar to switch to the To-Do list page. The Assigned 
Materials list shows all assigned items; items with a due date display at the top. 

4.  Click the Return to Instructor View  button in the upper-right 
corner of the course window.  
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Step 3: You may want to try out assignments so you know what the students will 
experience. 

 You can preview assignments in Instructor View, but if you want to check the 
grading system and feedback responses you must work in Student View. 

 When you work through an assessed activity in Student View, the grade is 
recorded in the Gradebook for the student_student account.  

 You can locate activities by navigating through the Course Content on the 
Course Materials tab in Student View. 

 If activities have been assigned, you can access them on the To-Do list on the 
Assignments tab in Student View. 

Trying Out a Concept Test 
1. Switch to Student View. 
2. Navigate to the location where the Concept Test is located—either the Course 

Materials tab or the To-Do list on the Assignments tab. 
3. Click the test to open the Test Presentation window.  
4. Select or enter the answer to the first question and then click Next Question. 
5. Repeat until you have answered all questions. 
6. After the last question, click Finish Submit for Grading, and then click Finish. 

The grade is available almost immediately to both the student and the teacher. 
The results display providing feedback as set in course preferences. Steps for 
viewing the grade/submission in Instructor view are below. 

Trying Out a File Upload Activity 
1. Switch to Student View. 
2. Navigate to the location where the File Upload Activity is located—either the 

Course Materials tab or the To-Do list on the Assignments tab. 
3. Click the activity to open the Dropbox [File Upload] window. 
4. Click the Choose File button. 
5. Navigate to the location where the file you want to upload is stored, then select it 

and click Open. 
6. Click the Add button to move it into the Upload box. 
7. Click Finish Submit for Grading, and then click Finish. Steps for viewing the 

grade/submission in Instructor view are below. 
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Trying Out a Grader Project 
1. Switch to Student View. 
2. Navigate to the location where the Grader Project is located—either the Course 

Materials tab or the To-Do list on the Assignments tab. 
3. Click the project to open the Test Presentation window. This window displays the 

steps for using the grader, and also step-by-instructions for completing the 
project. 

4. Click Download Files to download the application files. There will be at least two 
files for each grader: Instructions in Word document format, and the application 
file to use to complete the project. There may be additional files needed to 
complete the project. 

5. Click the down arrow on the right to download a single file, or click Download all 
Files to download them all at once as a ZIP compressed file. The download 
process depends on your operating system, but you can usually choose to open 
or save the files, and you can choose a storage location. 

a. If you download individual files, navigate to the download location and 
open the instructions and the application file. 

b. If you downloaded a ZIP, navigate to the download location and extract 
the files, and then open them. 

6. Once the files are downloaded, work through the steps of the project.  
7. The instructions can be printed, or you might choose to arrange the windows side 

by side to read the instructions while working in the application. Follow the steps 
exactly as written. 

8. When you have finished save and close the file and return to the Test 
Presentation window. 

9. Click Upload Completed File. 
10. Click Browse and navigate to the location where the application file is stored. 
11. Select the file to upload, and click Open. 
12.  Click Upload. When the file is uploaded, the Test Presentation window displays. 
13. Click Finish: Submit for Grading, and then click Finish. A message indicates if 

the submission was accepted. 
14. Click Return to Course to close the window. 
8. The grade is available almost immediately to both the student and the teacher. 

An icon indicates if a passing score was achieved. Steps for viewing the 
grade/submission in Instructor view are below. 
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Using the Gradebook 

 The Gradebook tab provides access to the section roster, student scores and 
submissions, and to reports.  

 There are three types of activities that are recorded in the Gradebook: 
automatically-graded Grader Projects, automatically-graded Concept Tests, 
and instructor-graded file uploads. 

 When you open the Gradebook, you see a list of all students and their 
cumulative grade to date. 

Step 1: To see the scores for a specific activity, you must locate it in the gradebook. 
You can do this using the Navigation Panel on the left side of the window by either 
clicking through the Course Content hierarchy or by using the Filters. 

Navigating the Course Content Hierarchy to Locate Lesson File Upload Scores 
1. Click the Gradebook tab. 
2. In the Navigation Panel, click the Learning Microsoft Office 2013 by Section 

folder. 
3. Click the Application folder. 
4. Click the Chapter folder. 
5. Click the Lesson folder. 
6. Click File Uploads. 
7. Click either Try Its or Projects. The Gradebook displays columns showing the 

scores for each file upload activity 
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Navigating the Course Content Hierarchy to Locate Chapter File Upload Scores 
1. Click the Gradebook tab. 
2. In the Navigation Panel, click the Learning Microsoft Office 2013 by Section 

folder. 
3. Click the Application folder. 
4. Click the Chapter folder. 
5. Click End of Chapter Projects and Tests. 
6. Click End of Chapter Upload Activities. The Gradebook displays columns 

showing the scores for each file upload activity 

Navigating the Course Content Hierarchy to Locate Concept Test Scores 
1. Click the Gradebook tab. 
2. In the Navigation Panel, click the Learning Microsoft Office 2013 by Section 

folder. 
3. Click the Application folder. 
4. Click the Chapter folder. 
5. Click End of Chapter Projects and Tests. 
6. Click Concept Tests. The Gradebook displays columns showing the scores for 

each Concept Test. 

Navigating the Course Content Hierarchy to Locate Grader Project Scores 
7. Click the Gradebook tab. 
8. In the Navigation Panel, click the Learning Microsoft Office 2013 by Section 

folder. 
9. Click the Application folder. 
10. Click the Chapter folder. 
11. Click End of Chapter Projects and Tests. 
12. Click Grader Projects. The Gradebook displays columns showing the scores for 

each Grader Project. 

Filtering the Gradebook 
1. Click the Up arrow to the left of View Filters.  
2. Select the filter to apply and select options as needed. 

Filtering by Title 
1. Click the Up arrow to the left of View Filters.  
2. In the Search Column Titles box at the bottom of the list of filters, type the title to 

find. For example, type Grader. 
3. Press Enter. Columns matching the search text display. Scroll right to view them 

all. 

Step 2: Viewing a Grade/Submission 

Viewing a Grade/Submission 
1. In the Gradebook, locate the score for the activity you want to view.  
2. Rest the mouse pointer on the score and click the Options down arrow. 
3. Click View Grade/Submission. If there are multiple submissions, click the one 

you want to view. 
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Step 3: Viewing the Class Roster 

Viewing the Roster 
1. In the Gradebook, click Manage Roster on the Menu bar. The list of all enrolled 

students displays, showing information such as the last time they logged in or 
out. 

Step 4: Running a Report 

Running a Report 
1. In the Gradebook, click Reports on the menu bar. The left side of the screen lists 

reports available for the course and the right side lists any reports you have run 
and saved. 

2. Click the report you want to run. 
3. Select options. Most reports let you select activity, student, and date options.  
4. If you think you will use the report again in the future, click to select the Save 

setting to My Reports check box. 
5. Click Run Report. You can view the report, print it, or download it. 

Accessing Grades and Submissions from Today's View 

Step 1: When a student submits a concept test or Grader Project for grading, the 
grade is calculated immediately and added to the Gradebook. An alert is sent to you 
and to the student and displays on the Today's View tab in the Notifications area. 
For example, if there are five new grades, you will see (5) to the right of the New 
Grades item. 

Viewing New Grades and Submissions: 
1. On the Today's View tab, click the New Grades notification. A list of activities 

with new grades displays in the Message area. 
2. Click an activity to open it in the Gradebook, 

OR 

 Click the activity's Options down arrow and click View All Submissions.  
3. If necessary, click the activity in the list on the left of the window. 

Step 2: When a student uploads a file for teaching grading, a notification displays 
next to Instructor Grading under Action Items on Today's View. 

Viewing and Grading an Uploaded File: 

1. On the Today's View tab, click the Instructor Grading Action item to display a 
list of file uploads in the Message area. 

2. Click the activity's Options down arrow and click View All Submissions. The 
grading window opens. (If more than one submission is available, click the 
submission you want to view in the list on the left.) 

3. Click the link to the uploaded file so you can assess it. 
4. Enter the grade and a comment, if you want.  
5. Click Save and Close. 
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Step 3: When a student submits a Grader Project for grading, the eCourse generates 
multiple reports to help guide your lesson planning and assessment. The reports are 
also available to student's in Student View.  

Viewing Detailed Grader Reports in Instructor View: 
1. Click the Gradebook tab. 
2. In the navigation pane on the left, navigate to the Grader Projects, or filter the 

display to show the Grader Projects. 
3. Click the Options drop-down arrow for the Grader Project score, and click View 

All Submissions to see the Scorecard report. The Scorecard shows each step 
in the project, the total number of points available, and the total number of points 
the student earned.  

4. Click Marked-up Report to see the completed file with green checkmarks 
indicating where a step was completed correctly, and a red X indicating where a 
step was missed. From the marked-up report you can choose to download the 
submission with Live Comments, which are detailed comments about each step, 
showing what was completed correctly and what was missed. 

5. Click Summary report to see only the steps where points were deducted. 

Viewing Detailed Grader Reports in Student View: 
6. Switch to Student View. 
7. Click the Grades tab. 
8. In the navigation pane on the left, navigate to the Grader Projects. 
9. Click the Options drop-down arrow for the Grader Project score, and click View 

All Submissions to see the Scorecard report. The Scorecard shows each step 
in the project, the total number of points available, and the total number of points 
the student earned.  

10. Click Marked-up Report to see the completed file with green checkmarks 
indicating where a step was completed correctly, and a red X indicating where a 
step was missed. From the marked-up report you can choose to download the 
submission with Live Comments, which are detailed comments about each step, 
showing what was completed correctly and what was missed. 

11. Click Summary report to see only the steps where points were deducted. 
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Using the eText 

 The eText is the Learning Microsoft Office 2013 book in digital format.  

 It opens in a separate window and includes a Navigation Pane for moving to a 
location in the book as well as a toolbar with buttons for commands such as 
highlighting and bookmark. These tools function the same way in both 
Student and Instructor view. 

 Use the toolbar buttons to access tools, such as the highlighter, notes, 
bookmarks tools, and zoom. Other tools let you change the view. Rest the 
mouse over a toolbar button to display a ScreenTip. 

 

 
 

To Search 

 Type the search term in the Search box  and click Go , 
then click the location in the Search results list.  

 Use the “Limit Results To” drop-down menu to narrow your search. 

 Click Browse to go back to the eText. 

 Click My Searches  to display a list of previously-used searches 

To Bookmark 

 To add a bookmark, click the Bookmark tool . 

 To view a list of bookmarks, click Bookmarks in the Navigation pane (usually 
below the Table of Contents.). Click a bookmark in the list to go to that page. 

 To delete a bookmark, go to the marked page and click the Bookmark tool . 

To Scroll 

To scroll through the eText, use the Next Page  or Previous Page  buttons on the 
toolbar, or click the Next Page or Previous Page bar along the sides of the page. 



eCourse Handbook for Teachers Page 21 

 
 

To Highlight 

 Click the Highlight tool  and drag to select the text to highlight.  

 To show or hide highlights, click the Highlight tool drop-down arrow, and click 
the option.  

 To delete a highlight, double-click it highlight and click the “X” button on the top 
right-hand corner.  

 To resize a highlight, double-click and drag to your desired size. 
(Highlights inserted by an instructor display in a different color from highlights inserted 
by the student.) 

To Add Notes 

 To add a note, click the Note tool , then click on the eText where you want to 
insert the note, and type. Click Save to save the note; click Close to Close it; click 
Edit to edit it or to delete it. 

 To show or hide notes, click the Note tool , drop-down arrow, and click the 
option.  

 To delete a note, double-click it, click Edit and then click Delete. 

 To view a list of notes, click Notes in the Navigation pane (usually below the 
Table of Contents.). Click a note in the list to go to that page. 

 Use the Notes Manager to search for a note, export a note to your desktop, or 

print your notes. Click the Note tool , drop-down arrow and click Open Notes 
Manager, 

To Print 
1. Display the page you want to print. 
2. Click Print on the menu bar in the upper-right of the eText window. 
3. Select Print options. 
4. Click Print 

Previous Page button 

Previous page bar 

Next page bar 

Next Page button 
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Using the Interactive eText Features 
 Click a highlighted key term to view the pop-up glossary. 

 Click a Video Clip symbol to play a video. 

 Click a File Icon symbol to open a data file. 

Accessing the Help Program 
1. Click Help on the menu bar in the upper-right corner of the course window. It is 

context sensitive, so opens to information about the current task. Use the Table 
of Contents or Search to locate different topics. 

Setting Course Preferences 

 Almost every aspect of the eCourse can be customized.  

 For most teachers, the default options will work fine, but as you get more 
comfortable with the course, you may want to explore some of the ways you 
can customize it for your own needs.  

 Keep in mind that most changes will only affect the current section; if you 
want to apply changes to multiple sections you need to customize the 
template.  

 However, although some preferences can be applied to the template and all of 
its sections, many can only be applied to the template. That's why 
customizing the template before creating sections can save time. 

Step 1: Access Course Preferences 

To Access Course Preferences 
1. Click Preferences in the upper right of the window, under the Home menu 

option. This opens the Preferences window with the General options displayed. 
For example, on this page you can change the time when activities are due. 

2. In the list in the left pane, click a Preferences category. The ones you are most 
likely to want to use are: 

 Grading, which has preferences such as the threshold score for passing 
and whether to use percentage grades or raw scores. 

 Activities, which lets you set preferences for each specific type of activity, 
such as how many tries a student has, and the type of feedback that will 
display. There are also general Activity preferences such as when to move 
an activity from the student's To-Do list to the Completed list. 

 Course Tools, which lets you enable the tabs to display in Instructor 
and/or Student view. For example, this is where you can select to display 
the Communicate tab which provides access to the internal email 
program. 

3. Select the preferences you want. 
4. Click Save Preferences. 
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5. Repeat steps 2-4 to set preferences in other categories. 
6. Click a tab such as Today's View or Course Materials to exit the Preferences 

window. 

Exiting the Course 

To Sign Out 
1. Click Sign out on the menu bar in the upper-right of the course window. 

To Return to the Program Administration Window 
1. Click Home on the menu bar in the upper-right of the course window. 

To Display the My Courses and Testbanks Page 
1. Click Home on the menu bar in the upper-right of the course window to display 

the Program Administration Window. 
2. Click View All Programs in the upper left of the window. 

Other Administration Tasks 
The Program Administration page has tabs for Users, Enrollments, and Reports.  
1. Use the information on the Users tab to view a list of students, teachers, or both 

enrolled in the course. 
2. Use the information on the Enrollments tab to view students and teachers enrolled in 

specific sections, and to move them from one section to another. Note that existing 
grades may not move with the students. 

3. Use the Reports tab to run reports that include students from multiple sections. For 
example, you can run a Usage Report to see how many times each student has 
logged in and how much time he or she has spent in the course. You can run an 
Activity Report to see grades and time on task for specific activities or for specific 
students. 
 Note, similar reports are available within each section. The difference is that from 

Program Administration you can include students from any section. 

Checking System Requirements 
1. Go to www.pearsoncustom.com/us/MSOffice2013. 
2. Under Login, click “Click Here”. 
3.  On the left side of the window, click System and Browser Requirements. 
 

http://www.pearsoncustom.com/us/MSOffice2013

